User Addendum

Fiery EXP250 Color Server, version 1.0SP1
for DocuColor 240/250

This addendum describes how to upgrade the Fiery EXP250 Color Server system software
to include features that were not covered in the version 1.0 release. The document also
supplements information in the user documentation about installable options and

Fiery EXP250 user software.

Before using the Fiery EXP250, read this User Addendum and distribute copies to all users.
For all other information and instructions, see the documentation that accompanies your

Fiery EXP250.

NoTe: The term “Fiery EXP250” is used in this document to refer to the Fiery EXP250 Color
Server. The Fiery EXP250 supports the DocuColor 240/250. The term “copier” is used in
this document to refer to the DocuColor 240/250.

New features in This document contains information about the following:
this update * Upgrade of Fiery EXP250 system software

Instructions are provided for installing the system software update in several ways. For
more information, see “Upgrading system software” on page 2.

* Installation of printer drivers

The EXP250 SP1 System Software Update CD also includes printer drivers that you must
install to use the Tray 6 (Oversized) option. For more information, see “Upgrading printer
drivers” on page 7.

*  Mac OS X printer driver choice

In addition to supporting the new Tray 6 (Oversized) option, the Mac OS X printer driver
in the system software upgrade also addresses issues on OS X v10.3 and v10.4.1 with
finisher options for folding and stapling. For more information, see “Two versions of Mac
OS X printer driver” on page 10.

* Cancel on Mismatch
A job whose media is not available can be cancelled after a specified timeout. See page 11.
* Support for Tray 6 (Oversized) option

Tray 6 (Oversized) is a new installable option that accommodates larger paper than the
regular Tray 6 option. For more information, see “Tray 6 (Oversized)” on page 11.
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* Tray 5 Media Protection

Copier damage is prevented with Tray 5 Media Protection if jobs printed from Tray 5
(Bypass) do not specify a media type. For more information, see “Tray 5 Media Protection
option” on page 15.

* Clarification of requirements for printing a duplex job in manual or semi-manual mode

Manual and semi-manual duplex printing is supported using either Tray 5 (Bypass) or Tray
6 (Oversized) as the paper source. For more information, see “Manual duplex printing
using Tray 5 (Bypass) or Tray 6 (Oversized)” on page 16.

This document also describes the optional Production Printing Package, which offers various
additional features to monitor and manage the print workflow of jobs on the Fiery EXP250.
For more information, see “Production Printing Package” on page 20.

Methods of upgrading system software

You can install the system update in a number of ways:

¢ System Updates from the Control Panel or Fiery Advanced Controller Interface (FACI)
e Check for Updates from WebTools

* From the EXP250 SP1 System Software Update CD

These methods are described below.

Note: Updated printer drivers can be installed from Check For Updates or from the EXP250
SP1 System Software Update CD. They can also be installed by Point and Print once they
have been installed on the Fiery EXP250.

Updating system software through System Updates from the Control Panel

You can access the System Updates utility from the Control Panel or from the FACI, if
installed.

The following procedure describes accessing System Updates from the Control Panel.
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TO CHECK FOR AND INSTALL UPDATES MANUALLY FROM THE CONTROL PANEL

1
2

Turn off the copier before installing updates.
Press the Menu button to access the Functions menu, and press System Updates.

System Updates checks the server for new updates and displays a message indicating whether
or not updates are available.

Press OK.

If updates are available, the message “Install now?” appears.

Select Yes and press OK.

Enter the administrator password, and press OK.

The updates are downloaded (if they have not already been downloaded) and installed.

If the updates require a server restart or a reboot, the Fiery EXP250 is automatically
restarted or rebooted when installation is complete.

There is a one-minute delay before a reboot.

When the Fiery EXP250 reaches the Idle state, turn on the copier.

Updating system software through System Updates from the FACI

You can configure System Updates to check for updates in several ways:

* Notify when updates are available: When updates are available, a pop-up message appears
next to the System Updates icon in the Windows taskbar on the FACI. Clicking the pop-
up message opens the System Updates window. This option requires that you download
and install the updates manually.

* Download the updates automatically and notify (faster installation): When updates are
available, a pop-up message appears next to the System Updates icon in the Windows
taskbar on the FACI. The updates are downloaded automatically but not installed.
Clicking the pop-up message opens the System Updates window. This option requires that
you install the updates manually.

* Automatically download and install updates, and reboot system: Updates are downloaded
and installed automatically. System Updates checks for available updates at a time and day
you specify, downloads and installs them, and reboots or restarts the server if required. No
notification is displayed and no user action is required.
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TO CONFIGURE SYSTEM UPDATES TO CHECK FOR UPDATES FROM THE FACI
1 Click Start and choose Programs>Fiery>System Updates.

System Updates Preferences

System updates checks for important updates of your
zoftware bazed on information about your computer and
current software.

Iv Check for impartant spstem updates
+ Matify when updates are available

" Download the updates automatically and notify
[faster installation)

" Automatically download and install updates,
and reboot the sypstem at:

| I~ [~
Prosy Settings Check Mow

()8 | Cancel |

Select the check box for Check for Important System Updates.

2 Select the option that describes how you want System Updates to respond when new updates
are available.

3 If you select Automatically download and install updates, choose a time of day and a day of
the week or Every Day from the menus.

4 Click OK.
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Installing system updates manually

If you selected a preference to be notified of system updates in the System Updates Preferences
window, a pop-up message appears when new updates are available. Click the pop-up message
to open the System Updates window.

To view a description of an update in the System Updates window, click to select the update

in the list.
4 System Updates Elilg‘
New upd are ilable for your system.
’ If you are not ready ta install now, you can use the 5pstem Lpdates
from the: Taskbar to install them later
18] | Title: | Size | Statug ~
1-FPAWSC Microsoft Security Bulletin M504-015 1MB Available
1-FAWSE Microsoft Security Bulletin M504-023 E47 KB Available
1-FAwRU Microsoft Security Bulletin M5 04-024 4 MB Available
1-FAWRO0 Critical Update for Miciosoft Data [KBS70EE3] 305 KB Available
1-FPAWDL Microsoft Security Bulletin M5 04-022 1MB Available
1-GH1KD Microsoft Security Bulletin M504-032 EMB Available
1-GHTKEE Microsoft Security Bulletin M5 04-037 4 MB Available
1-GH1KR Mirrnznft Sreonitu Rullelin M5 04038 A MR Availahle o
< >
Drescription:
Install 1

If you do not want to install new updates immediately, you can click Exit to close the window.
To open the window again, click the System Updates icon in the Taskbar and choose Check
System Updates.

TO INSTALL NEW UPDATES FROM THE FACI

1
2

Turn off the copier before you install updates.
Click Install All in the System Updates window.
The updates are downloaded (if they have not already been downloaded) and installed.

If the updates require a server restart or a reboot, the Fiery EXP250 is automatically
restarted or rebooted when installation is complete.

There is a one-minute delay before a reboot.

When the Fiery EXP250 reaches the Idle state, turn on the copier.
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Updating system software through WebTools

You can also check for system software updates from a secure site on the Internet. Updates to
user software may also be available.

TO CHECK FOR SOFTWARE UPDATES

1
2
3

Start WebTools.

Type the Administrator password and click OK.

Click Software Updates.

If Software Updates does not appear as one of the WebTools, click Configure and enable it.
If an update is available, click the update.

The update is downloaded to the Fiery EXP250.

For information about installing the update, click the ReadMe file provided with the update.

Installing the EXP250 SP1 System Software Update from the CD
Before installing this system update, print the Fiery EXP250 Configuration page.

Make sure the Fiery EXP250 is Idle and temporarily remove any dongle attached to the
Fiery EXP250.

Insert the EXP250 SP1 System Software Update CD into a computer that can print to the
Fiery EXP250 and has Command WorkStation installed.

If Command WorkStation is installed directly on the Fiery EXP250, you can insert the CD in
the DVD drive of the Fiery EXP250.

NoTEe: You can also download files from a Windows or a Mac OS computer using
Downloader or WebDownloader. For more information about downloading files using these
utilities, see Utilities.

Start Command WorkStation and connect to the Fiery EXP250.
If you experience any problems, make sure Setup is configured properly.
Choose File>Import>Job from the Command WorkStation menu.

Navigate to the “System SW Update.ps” directory on the EXP250 SP1 System Software
Update CD, select the update file, and click Add.

Choose the Print or Direct connection from the Logical Printer menu.
Click Import and wait for the Fiery EXP250 to reach idle after downloading the update.

You must wait at least 60 seconds after the patch file is imported before rebooting the system.
This will ensure the patch file is completely processed.

Remove the EXP250 SP1 System Software Update CD from the Fiery EXP250 or remote
computer.
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After the Fiery EXP250 reaches idle, reboot the Fiery EXP250.

Using the Fiery EXP250 Control Panel, choose Shut Down from the Functions menu, and
then choose Reboot System.

The Control Panel should display the version as version 1.0SP1.

Wait until the Fiery EXP250 has come to idle after the second reboot to print the
Configuration page.

Print a Configuration page and verify that the Update Information section includes the name
of the update file (the file name appears without the .ps extension).

New Fiery EXP250 printer drivers
The EXP250 SP1 System Software Update CD contains updated Fiery EXP250 printer

drivers.

You can install printer drivers in a number of ways:
* From the Fiery EXP250 through Point and Print using SMB printing (Windows only).

*  From WebTools, using Installer or Check for Updates to download the printer driver files
before you install them.

e From the EXP250 SP1 System Software Update CD.

Before installing the updated printer drivers, you must manually uninstall the existing
Windows and Mac OS X printer drivers.
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Uninstalling Fiery EXP250 printer drivers

To uninstall Windows printer drivers, refer to the section “Using Fiery Printer Delete Utility”
in the Printing Utilities chapter of Printing from Windows on the User Documentation CD.

To uninstall Mac OS X printer drivers, use the following procedure.

To REMOVE THE MAC OS X PRINTER DRIVER

1
2

Delete the Fiery EXP250 printer from the desktop.

Delete the following files:

* /Library/Frameworks/h10.framework

* /Library/Frameworks/hcore.framework

* /Library/Frameworks/hefi_color.framework

To remove the version 1.0 printer driver plug ins, delete the following files:
* /Library/Printers/PPD Plugins/EF4X2012 (CW)

* /Library/Printers/PPD Plugins/EF4X2012 (FJN)

* /Library/Printers/PPD Plugins/EF4X2012 (IS)
 /Library/Printers/PPD Plugins/EF4X2012 (PINFO)

To remove the updated version 1.0 printer driver plug ins, delete the following files:
* /Library/Printers/Xerox/PDEs/EF6X2012 (CW)

* /Library/Printers/Xerox/PDEs/EF6X2012 (FJN)

¢ /Library/Printers/Xerox/PDEs/EF6X2012 (IS)

¢ /Library/Printers/Xerox/PDEs/EF6X2012 (PINFO)

Browse to /Library/Printers/PPDs/Contents/Resources and delete the PPD files Fiery EXP250
PS in each corresponding language folder as necessary.

For example, to delete the English PPDs, you delete /Library/Printers/PPDs/Contents/
Resources/en.lproj/Fiery EXP250 PS v1.0.
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6 Delete the fierycupsfilter with the Terminal utility (requires root administrator password).

* Open the Terminal utility by browsing to /Applications/Utilities/ Terminal. Double-click
Terminal to launch the utility.

* Change to the fierycupsfilter directory by entering
cd /usr/libexec/cups/filter
The command prompt reflects the new directory.
* Enter
sudo rm -r fierycupsfilter
* Enter the root password.
By default this password is blank. Press Enter to proceed.

The fierycupsfilter is deleted, and the printer driver has been removed.

Installing Fiery EXP250 printer drivers
To install the updated drivers on Windows computers, refer to the Installing Printer Drivers

chapter of Printing from Windows.

To install the updated drivers on Mac OS 9, refer to the Setting Up Printing on Mac OS 9
chapter in Printing from Mac OS.

To install the updated drivers on Mac OS X, see the Setting Up Printing on Mac OS X
chapter in Printing from Mac OS.

NoTE: You can install a Fast version or a Comprehensive version of the Mac OS X printer
driver. For more information, see “Two versions of Mac OS X printer driver” on page 10.
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Two versions of Mac 0S X printer driver

When you install the updated Mac OS X printer driver, you can install a Fast version, which
does not check for incompatible print option settings but runs faster, or a Comprehensive
version, which prevents you from choosing incompatible print option settings at the expense
of some processing time. A dialog box in the OS X installer lets you choose the version.

Select printer version to install

=Fast
Opens quickly by not checking for constraints
between mutually exclusive printer feature settings.

=Comprehensive
Takes extra time to check for constraints.

& Comprehensive ) ( Fast )

The Fast version addresses issues with folding and stapling on Mac OS X v10.3 and v10.4.1.
Use the Fast version if the copier is configured with a finisher and you want to print folded
and/or stapled jobs on Mac OS X v10.3 or v10.4.1. Be aware that if you choose incompatible
print option settings, your job might not print as expected.

NoTEe: You do not need to use the Fast version to print folded and/or stapled jobs on

Mac OS X v10.4.2 and later. If you have Mac OS X v10.4.2 or later, we recommend
installing the Comprehensive version to have the benefit of checking for incompatible print
option settings.

If you install the Comprehensive version and then later decide to install the Fast version, you
must remove the Comprehensive version first, using the procedure on page 8.

Be sure to remove any previous Fiery EXP250 printer drivers before installing the upgraded
printer drivers. For more information, see page 8.
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Cancel on Mismatch option

The Cancel on Mismatch option causes a job to be cancelled if the media specified for the job
(size and weight) is not available. The job is cancelled with an error and moved to the Printed
queue, allowing the Fiery EXP250 to continue printing other jobs.

The Cancel on Mismatch Timeout option specifies the number of minutes that the
Fiery EXP250 waits before cancelling a mismatched job. The default setting is 5 minutes, and
the maximum setting is 999 minutes. To disable this option, set the timeout value to 0.

You can set the Cancel on Mismatch option in Server Setup on the Fiery EXP250 Control
Panel, or in General Setup on the FACI, if a FACI is installed.

Using the Tray 6 (Oversized) option

An additional high-capacity feeder paper tray option is supported, Tray 6 (Oversized). Tray 6
(Oversized) can accommodate the following paper sizes: Letter, Tabloid, Legal, A4, A3, 13x9
SEE SRA3 SEF, 12x18 SEF, 11x17 SEE, A3 SEF, B4 SEE 8.5x14 SEF 8.5x13 SEE, B5 LEE,
A4 LEF, A4 SEF, 8.5x11 SEF, 8.5x11 LEF and PostScript Custom Page Size. The copier can
be configured with this option instead of the regular Tray 6.

To print using the Tray 6 (Oversized) option, you must install the updated printer drivers,
configure the Tray 6 (Oversized) installable option, and set the Paper Source print option to
Tray 6 (Oversized).

Configuring printer drivers for Tray 6 (Oversized)

Before using Tray 6 (Oversized) for printing jobs, you must configure the Tray 6 (Oversized)
installable option in the printer drivers.

TO INSTALL AND CONFIGURE THE UPDATED VERSION 1.0 PRINTER DRIVER ON WINDOWS

1 If the version 1.0 printer driver is installed, remove it using the Fiery Printer Delete Utility.

For more information on using this utility, see the Printing Utilities chapter of Printing from
Windows.

Install the updated version 1.0 printer driver either from the CD or using WebTools.

For more information, see the Installing Printer Drivers and Setting Up Printing Connections
chapters of Printing from Windows.

Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start, and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.

4 Click the Fiery EXP250 icon and choose Properties from the File menu.
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5 Click the Accessories tab.

&% Aero Properties

2=

General I Sharing I Ports Advanced I Colar Management I Security Device Settings I
Consumables Acocessolies | Abaut

;.a Available Options:
Advanced Finisher [EU)

i
Advanced Finisher [NA) = —_—
Profeszional Finisher [EU]

Professional Finisher [NA] b
Trav B

Tray B [Oversized)

Add Remaoyve

Ea
ﬁ Installed Dptions: -~ Two-Way C
Printer IP Address or, DN5 Name

[~ Update Fiery Driver When Opened

Update

Defaults |

oK I Cancel | Apply | Help |

6 To manually set the Tray 6 (Oversized) option, select the option in the Available Options list,
and click Add to move the option to the Installed Options list.

7 Alternatively, to configure installed options automatically by retrieving the settings from the
Fiery EXP250, select Two-Way Communication, type the Fiery EXP250 IP address or DNS
name, and click Update.

If the Tray 6 (Oversized) option is configured at the server, it appears under Installed Options.

&% Aero Properties 21|
General I Sharing I Ports Advanced I Colar Management I Security Device Settings I
Consumables Acocessolies | About
;.a Awailable Ophtions:
Advanced Finisher (EL) gl
Advanced Finisher (MA)] - 3
Professional Finisher [NA)] —
Tray 6 o
T T Lo |
Add Remaove
prd
Ea
ﬁ Installed Options: ¥ Two-Way C
Professional Finisher (EL] Printer IP Address or DNS Mame
Tray B [Oversized)
[10105573
¥ Update Fiery Driver When Opened
™ Enable E-mail Notification
E-tzil Address
Defaults |
Ok | Cancel Apply Help

8 Click Apply, and then click OK.
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TO INSTALL AND CONFIGURE THE UPDATED VERSION 1.0 PRINTER DRIVER ON MAC 0S X

1 If the version 1.0 printer driver is installed, remove it.

For instructions, see page 8.

2 Install the updated version 1.0 printer driver either from the CD or using WebTools.

You can install a Fast version or a Comprehensive version. For more information, see “Two

versions of Mac OS X printer driver” on page 10.

For more information on installing and configuring the printer driver, see the Setting Up

Printing on Mac OS X chapter of Printing from Mac OS.

3 Choose Utilities from the Go menu, and start Printer Setup Utility (or Print Center).

4 Select your printer in the Printer List.

ene Printer List =)
H - = X
default | Add  De y y f
In Menu Name Status
=) ASAMA_Print m
] ASAMA_Hold
™ hold on 10.11.143.55 "y
=) Aero v
“4|» /

5 Choose Show Info from the Printers menu.

6 Choose Installable Options.

7 For Optional Trays, select Tray 6 (Oversized).

600 Printer Info

— Aero

4{ Installable Options

D S

Finisher Option: 'None

=

Optional Trays: | Tray 6 (Oversized) B

Apply Changes

8 Click Apply Changes.

9 Close the window.
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To INSTALL AND CONFIGURE THE UPDATED VERSION 1.0 PRINTER DRIVER ON MAC OS 9

1

10
11
12

If the version 1.0 printer driver is installed, remove it.
Install the updated version 1.0 printer driver either from the CD or using WebTools.

For more information on installing and configuring the printer driver, see the Setting Up
Printing on Mac OS 9 chapter of Printing from Mac OS.

Select Chooser from the Apple menu.

Make sure AppleTalk is set to Active.

Click the Adobe PS icon.

If your network is divided into zones, select the zone in which the Fiery EXP250 is located.

The Fiery EXP250 appears in the Select a PostScript Printer list in the form of <server

name>_<print connection>.

NoTe: Only the print connections (Print, Hold, and Direct) that have been enabled appear in
the Chooser.

Select a Fiery EXP250 connection from the “Select a PostScript Printer” list and click Create.
Select the correct printer description file for your printer and click Select.

Click Setup and click Configure.

In the Installable Options dialog box, select the Tray 6 (Oversized) option.

Click OK and then click OK again.

Close the Chooser.
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Tray 5 Media Protection option

By default, a job prints with the copier’s default media type, which is Plain, because the

default setting for the Media Type print option is Use Machine Settings. However, Tray 5

(Bypass) does not detect the media type actually loaded in the tray. If users load heavyweight

media in Tray 5, the copier still prints for plain media, which can damage the fuser.

The Tray 5 Protection option protects the fuser by automatically printing for Heavyweight 2

media for jobs that have all of the following conditions:

* Paper Source is Tray 5 (Bypass)

* Media type is not specified

* The copier media type is set to one of the following:

Plain
Recycled
Plain (Side 2)
Hole Punched
Custom 1
Custom 2
Custom 3
Custom 4

Custom 5

If you want to print from Tray 5 (Bypass) for plain media, you must select Plain as the Media

Type for the job. Or, you can disable the Tray 5 Media Protection option.

You can set the Tray 5 Media Protection option in Fiery Server Setup, under the General

Setup tab. It is disabled by default.
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Manual duplex printing using Tray 5 (Bypass) or Tray 6 (Oversized)

Manual duplex printing is supported using either Tray 5 (Bypass) or Tray 6 (Oversized) as the
paper source. You can print duplex output in a fully manual mode, determining the required
paper manipulation yourself, or you can print in a semi-manual mode, in which the

Fiery EXP250 prompts you to perform the manual steps required.

TO PRINT IN A FULLY MANUAL MODE

1

Print two jobs: the first containing the even-numbered (Side 2) pages, and the second
containing the odd-numbered (Side 1) pages.

Since the jobs are separate, you can even print from different applications if desired. Or you
can print from one document, but print even-numbered pages as one job and odd-numbered

pages as one job.

For the first job, set the print options as follows:

* Face-Down Printing = Face Up

* Paper Source = Tray 5 (Bypass) or Tray 6 (Oversized)

* DPage Size and Media Type = type of media loaded in the Paper Source
Print the first job.

Notice how the pages are oriented in the output tray before removing them.

Turn the pages over so that the printed side faces down and load them back in the same tray
used to print the first job.

Depending on how you flip the pages, you can print Side 1 with the same orientation as
Side 2 (Top-Top) or rotated 180 degrees relative to Side 2 (Top-Bottom). The illustration
below shows the output for Top-Top and Top-Bottom for both Portrait and Landscape jobs.

Top-Top Top-Bottom
Portrait
O OO o N ¢
A A A
\Y
1 2 1 O O
Landscape
o n o O o n rA
A A A \Y4
1 2 1 O O

For Top-Top printing, keep the pages oriented the same way as they were in the output tray,
except face down. For example, if the pages are upside down and face up, load them upside
down and face down.
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NoTE: The illustrations below show pages with Portrait orientation printed LEF (Long Edge
First).

= BE =

Output Tray Input Tray

Top-Top printing

For Top-Bottom printing, rotate the pages 180 degrees and turn them face down.

Output Tray Input Tray

Top-Bottom printing

NoTE: For jobs imposed using Impose, always flip the pages along the long edge of the page.

6 Print the second job with the same settings as the first, but set the Media Type to the Side 2
setting that corresponds to the Media Type you used for the first job.

For example, if you printed the first job using Plain (64-105 gsm), print the second job using
Plain (Side 2) (64-105 gsm).
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TO PRINT IN SEMI-MANUAL MODE

1 Choose Print in your application.
2 Set the print options as follows:

* Manual Duplex = Manual

* Face-Down Printing = Face Up

* Paper Source = Tray 5 (Bypass) or Tray 6 (Oversized)
3 Print the job.

The even-numbered pages are printed.

N

If you are printing from Tray 5 (Bypass), remove any unused paper from the tray.

5 Notice how the pages are oriented in the output tray before removing them.

(=]

Turn the pages over so that the printed side faces down and load them back in the same tray
used to print the first side.

Depending on how you load the pages, you can print Side 2 with the same orientation as
Side 1 (Top-Top) or rotated 180 degrees relative to Side 1 (Top-Bottom).

Top-Top Top-Bottom
Portrait
O m OO on ¢
A A A
1 2 1 O O
Landscape
o n O O o n r4
A A \V4
1 2 1 O O

For Top-Top printing, keep the pages oriented the same way as they were in the output tray,
except face down. For example, if the pages are upside down and face up, load them upside
down and face down.
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NoTE: The illustrations below show pages with Portrait orientation printed LEF (Long Edge
First).

= BE =

Output Tray Input Tray

Top-Top printing

For Top-Bottom printing, rotate the pages 180 degrees and turn them face down.

Output Tray Input Tray

Top-Bottom printing

7 For Tray 6 (Oversized), press the Start button on the copier control panel.
Tray 5 (Bypass) will detect that the pages have been loaded, so you do not need to press Start.
The odd-numbered pages are printed.
NoTe: For jobs imposed using Impose, always flip the pages along the long edge of the page.
8 Place the pages in the same tray you used to print the even-numbered pages.

Do not rotate the pages. Load them in the same direction (long edge first or short edge first)
as when you printed Side 1.

The odd-numbered pages are printed.
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Production Printing Package features

The Production Printing Package (available as an option) offers Fiery EXP250 operators
(or users with Operator or Administrator privileges) various additional features to monitor
and manage the print workflow of jobs on the Fiery EXP250. All the features are accessible
from Command WorkStation, Windows Edition. Schedule Printing is also accessible from
Command WorkStation, Macintosh Edition. The features include the following:

e Compose

* DPaper Catalog

* Process Next/Print Next

¢ Job Reorder

* Suspend on Mismatch

* Rush Printing

* Schedule Printing (also available from Command WorkStation, Macintosh Edition)
e Insert Tabs

¢ Microsoft Office filters for Hot Folders

Installing Production Printing Package software

Production Printing Package is installed with Command WorkStation and is enabled on the
Fiery EXP250, if supported. The features are only available in Command WorkStation when
the client workstation is connected to the Fiery EXP250 on which the Production Printing
Package features have been enabled.

For information about installing and configuring Command WorkStation, Windows Edition,
and Command WorkStation, Macintosh Edition, see Utilities.

For information about enabling Production Printing Package on the Fiery EXP250, see the
documentation that accompanies the Production Printing Package option kit.

For complete instructions on how to use the standard Command WorkStation features, see
Command WorkStation Help. For instructions on how to access Command WorkStation
Help, see Utilities.

The following sections describe how to access and use the features of the Production
Printing Package.
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Compose

The Compose application allows you to define the chapter divisions of a job, print ranges
of pages on varying types of media, insert blank media between pages, and insert tab media
containing text labels. You can also preview the job as thumbnails and full screen previews,
and edit documents using Acrobat and PitStop.

A special dongle must be installed on each workstation that runs Compose. For more
information about the dongle and installing it, see the documentation that accompanies
the Compose kit.

To use Compose, you must also install Acrobat and PitStop on the client workstation.
Installers for Acrobat and PitStop are provided in the Compose kit. For information about
installing Acrobat and PitStop, see the documentation that accompanies the Compose kit.

For complete instructions on how to use Compose, see Compose Help.

To Access CoMPOSE AND COMPOSE HELP

1 Select a spooled/held job in the Active Jobs window and choose Compose from the

Actions menu, or right-click the job and choose Compose from the menu that appears.

2 Choose Help from the Help menu.

If you have the Compose feature, we recommend that you use it instead of Mixed Media.

Paper Catalog

Paper Catalog is a system-based paper warehouse database that stores attributes of any media
available for printing from the Fiery EXP250. You can select media for your job from the
selections listed in Paper Catalog.

Access Paper Catalog from any of the following:
* Command WorkStation

* Paper/Tray Association

* Compose

e Mixed Media Setup

* Job Properties

The following sections describe how to access and use Paper Catalog from each of these
interfaces.
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To ACCESS PAPER CATALOG FROM COMMAND WORKSTATION

¢ To open Paper Catalog from Command WorkStation, select a spooled/held job in the Active
Jobs window and choose Paper Catalog from the Server menu.

@ For information about using Paper Catalog, access Paper Catalog Help from the Paper
Catalog Help menu or press the F1 key on your keyboard. Only administrators can configure
and edit Paper Catalog entries and settings.

To ACCESS PAPER CATALOG FROM PAPER/TRAY ASSOCIATION

e Select a spooled/held job in the Active Jobs window and choose Paper/Tray Association from
the Command WorkStation Server menu.

@ For information about using Paper/Tray Association, access Paper Catalog Help by pressing
the F1 key on your keyboard.

To AcCess PAPER CATALOG FROM COMPOSE

¢ Select a spooled/held job in the Active Jobs window, choose Compose from the Actions menu,
and then choose Paper Catalog from the Compose File menu.

@ For information about using Compose, see Compose Help. Information about how to apply
Paper Catalog entries to your job is also described in Compose Help.

To ACCESS PAPER CATALOG FROM MIXED MEDIA SETUP

1 Select a spooled/held job in the Active Jobs windows and choose Mixed Media Setup from the
Command WorkStation Actions menu.

2 Click Paper Catalog in the Define Cover, Define Page Range, or Insert Blank windows.

For more information about Mixed Media Setup, see Utilities.

To ACCESS PAPER CATALOG FROM JOB PROPERTIES

1 Select a spooled/held job in the Active Jobs window, and choose Properties from the
Command WorkStation Actions menu.

2 In the Job Properties dialog box, click the Paper Source option bar, and then click Paper
Catalog.

3 Select the required media and click OK.
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Reorder Jobs

The Fiery EXP250 processes and prints batches of selected jobs in order of each job’s place in
the queue. The Reorder Jobs feature allows you to control the processing or printing priority
by reordering the job queue. When you promote jobs in the queue, these jobs take priority
over the rest of the jobs on the Fiery EXP250.

For example, you can reorder the queue to group together jobs with similar print options,
such as media or tray selections. When you select the jobs and apply the Print command,
batches of jobs with similar options are printed together.

s

-:Q:— To reorder jobs, you must log on to the Fiery EXP250 with Administrator privileges.

TO REORDER JOBS

1 Choose Reorder Jobs from the Server menu.

The Reorder Jobs dialog box appears.

=]
Order /| Jo Title User
1 lustrator! 0_NSeparstionsOM ps Adminis _.
2 lustrator 0_NSeparationsOF ps Adminiz
3 CMYH text ps Adminiz
4 PPMLColortutorial zip nlyons
5 PPMLCaolortutorial zip.dhp nlyons *
| o
spooledheld
|

Done I Caneel |

A

2 Click the tab for the type of job that you want to reorder.
The Fiery EXP250 supports the reordering of spooled/held jobs, processed/held jobs, and

jobs that are waiting to process.
3 Select the job(s) that you want to reorder.

Press Ctrl and click to select multiple jobs. Press Shift and click to select a range of jobs.
4 Reorder the selected job(s).

To shift the job priority up or down, click the Move Up or Move Down button. To move
the job(s) to top or bottom priority, click the Move to Top or Move to Bottom button.

Jobs at the top of the list take priority over jobs at the bottom.

5 When you finish defining the order, click Done.
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Suspend on Mismatch

Suspend on Mismatch puts a job on hold when the Fiery EXP250 cannot start printing due
to missing resources or a color profile mismatch. Other jobs in the queue continue to print on
the Fiery EXP250.

The reasons for a job being suspended are:
* Specified paper type or size are not available.

* Finishing option is not available.

Checking for missing resources is done before a job is printed, not during printing. If needed
resources are missing, the Job Status column in Command WorkStation displays “Printing
Suspended.” Double-clicking a suspended job opens an error window that explains why the
job was suspended.

The following restrictions apply to Suspend on Mismatch:

* Suspend on Mismatch must be enabled in Fiery EXP250 Server Setup.
* Checking is performed on the first page of each job.

* Rush Printing jobs are not checked for Suspend on Mismatch.

* Only jobs sent to the Print or Hold queues are checked for Suspend on Mismatch.
Jobs sent to the Direct connection are not checked.

When a job is suspended, you can take any one of the following actions:
Open the Job Properties window to edit the properties of the suspended job.

Choose Print from the Actions menu to release the job for printing. The Fiery EXP250
rechecks for missing resources and suspends the job if the needed resources are still missing.

Cancel the suspended job, whereupon the job becomes a regular held/processed job.

Delete the suspended job.

Rush Printing

The Rush Printing feature allows you to print a job immediately, pausing any other jobs that
are currently printing. After the Rush Printing job is complete, the paused jobs resume
printing.

To MARK A J0B FOR RUSH PRINTING

Select a job in the Active Jobs window and choose Rush Printing from the Actions menu, or
right-click the job and choose Rush Printing from the menu that appears.
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Schedule Printing

The Schedule Printing feature allows you to set a specific date and time for printing a job.
Assign Schedule Printing settings to a job from the following areas:

* Job Properties window in Command WorkStation, Windows Edition, and Command
WorkStation, Macintosh Edition (see Command WorkStation Help and the following
procedure)

¢ Active Jobs window in Command WorkStation, Windows Edition, and Command
WorkStation, Macintosh Edition (see the following procedures).

Command WorkStation, Windows Edition, also allows you to search for jobs that have been
scheduled for printing.

TO SCHEDULE A JOB FOR PRINTING FROM THE ACTIVE JOBS WINDOW

1 Select a job in the Active Jobs window and choose Schedule Printing from the Actions menu.

2 Specify the date and time when you want the job printed and click OK.

TO SCHEDULE A JOB FOR PRINTING FROM THE JOB PROPERTIES WINDOW IN COMMAND WORKSTATION,
WiINDOwS EDITION

1 Select a job in the Active Jobs window and choose Properties from the Actions menu.
2 Expand the Destination option bar.

3 Select Schedule Printing, specify the date and time when you want the job printed, and
click OK.

@ Note: Display the scheduled date and time by adding a Schedule Printing information
column to the Active Jobs window. For information about adding information columns, see

Command WorkStation Help.

To FIND SCHEDULED JOBS IN COMMAND WORKSTATION, WINDOWS EDITION
e Choose Find Scheduled Jobs from the Edit menu.

A window displays the search results.

TO SCHEDULE A JOB FOR PRINTING FROM THE JOB PROPERTIES WINDOW IN COMMAND WORKSTATION,
MACINTOSH EDITION

1 Select a job in the Active Jobs window and choose Properties from the Actions menu.
2 Expand the Job option bar.

3 Click the text field to the right of Schedule Printing, specify the date and time you want the
job to print, and then click OK.

@ NoTE: Display the scheduled date and time by adding Schedule Printing information to the
Active Jobs window. For information about adding information columns, see Command
WorkStation Help.
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Print Next

The Print Next feature moves a selected job immediately to the printing queue. If another job
is currently printing, the selected job for Print Next is printed immediately after.

Process Next

The Process Next feature moves the selected job immediately to the processing queue.
If another job is currently processing, the selected job for Process Next is processed
immediately after.

Insert Tabs

The Insert Tabs feature, which is accessed from Mixed Media Setup, allows you to insert tab
pages throughout a job. This feature accommodates various sizes and types of tab media stock.
Users can input text for each tab and specify the location of the tab within the document.

Insert Tabs is only supported if the copier supports tab printing.
For more information about Mixed Media, see Utilities.

NoTe: The Insert Tabs feature is not available for imposed jobs.

TO INSERT TAB PAGES

1 Select a spooled/held job in the Active Jobs window, and choose Mixed Media Setup from the
Actions menu.

The Mixed Media dialog box appears.

5,
—Chapter Desi
Chapter Start Page([s): I [separate page number by comma)

I~ Define Each Chagter fis 4 S eparate Fnishing Set

-'@Mixed Media Definiti

Page Range | Duplex Media Type Cover Page ... | Tab Shift Define Cover |
Bodl o Use Machine S Frinters Defaul Mone =

Define Page Range... |

Insert Tah |

Insert Blank. |

Edit... |

4 | ﬂ Femove |

Preview Cancel
2 Click Insert Tab in the Mixed Media dialog box.
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The Insert Tab dialog box appears.

Insert Tab x|
Total number of tabs: I 3:
~ Tab Setti
ab wetling Load Setting... I
Mumber of tabs in a set: |5 3‘ i
=1 leuts) Save Setting... I
P N lected
aper Mame none selecte e e I
Duplex IDocumentDefauIl j
Media Type IDocument Default -
Paper Source IDocument Default -
Page Size IDocument Default -
Text Attributes...
Ok I Cancel |

To load a previously saved tab setting, click Load Setting, highlight the desired tab setting,
and then click Select.

Enter the number of tab pages that you want to insert into the document in the Total number
of tabs field.

Enter the number of tab positions included in a complete tab set in the Number of tabs in a
set field.

This specification ensures that tab text is printed in the correct tab positions. For example,
tab positions in a set consisting of 10 tabs are distinct from tab positions in a set consisting

of 5 tabs.

Specify media type, paper source, and page size settings for the tab stock.

Page Size values refer to the dimensions of the stock, including the tabbed portion.
Click Paper Catalog to access the media selections in the Paper Catalog.

Select the required media and click OK.

The media you select appears next to Paper Name in the Insert Tab dialog box.
For more information about Paper Catalog, see page 21.

To specify attributes for the tab text, click Text Attributes.

You can also set text attributes after you close the Insert Tab dialog box. For more
information, see “To specify tab text” on page 28.

To save the current Insert Tab specifications as a tab setting, click Save Setting, assign the
tab setting a name, and then click Save.



11 After you finish specifying the tabs, click OK to close the Insert Tab dialog box.

The Tabs Text dialog box appears. Use the following procedure to define the tab text.

[~ Apply same text attributes for all tabs Text Attributes.

Page | Tab Text |

Text Attributes...

57| @]

Tent Attributes...

@]

Text Attributes... I

Change Tab Settings. | 0K I Cancel

TO SPECIFY TAB TEXT

1 In the Tabs Text dialog box, select the “Apply same text attributes for all tabs” option to
assign the same text attributes to all tabs.

2 C(lick Text Attributes.

Specify the rotation, alignment, font, and size attributes of the tab text, and then click OK.
3 Indicate where you want each tab inserted in the document.

* In the Page field, type the page number where you want the tab inserted.

* Use the insertion icon to control whether the tab is inserted before or after the specified
page number. Click the icon to toggle between insertion modes. The icon preview and
tooltip change to reflect the current insertion mode. To display the tooltip, position the
pointer over the insertion icon.

m Sample Text

Inzert Tab After Page 1 [at Attibutes. . |

NoTE: If you define a tab to be inserted between an odd-numbered page and an even-
numbered page in a duplex job, the tab is inserted after the odd-numbered page on the first

sheet, and the even-numbered page is printed on the next sheet.
4 Type the tab text that you want for each tab in the Tab Text field.

To define text attributes for each tab individually, click Text Attributes for that tab.
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5 To modify media settings for the tabs, click Change Tab Settings.
For more information, see “To insert tab pages” on page 26.
6 After you finish specifying tab text, click OK to close the Tabs Text dialog box.

The Mixed Media dialog box displays the current tab settings in the Mixed Media
Definition list.

7 To apply your Insert Tab settings to the document, click OK to close the Mixed Media dialog

box, and then click OK again to close the Job Properties dialog box.

Microsoft Office filters for Hot Folders

The Microsoft Office filters for Hot Folders feature allows you to convert certain MS Office
file formats to PostScript. File conversion takes place on your computer within Hot Folders,
which saves Fiery EXP250 resources. You can print files directly from Hot Folders filters
without starting the application from which they were created.

The Microsoft Office filters have no configurable options; however, you must have the
following versions of each application, and have a PostScript printer or Acrobat Distiller
installed to convert the files to PostScript files.

¢ Microsoft Excel 2000

* Microsoft Publisher 2002

¢ Microsoft PowerPoint 2000
¢ Microsoft Word 2000
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Specifying filter settings for a Hot Folder
After specifying the filter settings and options for your Hot Folder, drag and drop the proper

file formats onto your Hot Folder to begin the conversion process.

Open the Filter Settings dialog box from the Folder Properties dialog box.

TO SELECT A FILTER SETTING

1 From the Hot Folders Control Panel, select the Hot Folder and click Properties.

2 Select Filter Settings and click Define.

The Filter Settings dialog box appears, allowing you to select the filter.

Filter Settings @|
Mame ‘ File Type -~
] ExportPS (Exclusive) pE.EpE
[[]JPEG to POF Jipeg
Microsoft Excel s
Microgoft PowerPoint .ppt.ppz
Micrazoft Publisher .pub
Cro el 3 [Fxclusive) nlf v
< »

Microsoft Word
Outputs PS. Micrasoft Ward 2000 or newer and a PostSeript printer o
Acrobat Distiler rmust be installed for this fiker to be accessed.

Printer Name Aero j ‘

PS-»PDF Nomnalizer
[ Corveert PS to PDF

Distiller Profile J

Cancel

For Windows, filters are color-coded. Exclusive filters are blue and Non-exclusive filters are
black.

If you select an Exclusive filter, you cannot select any other filter. Microsoft Office filters are

Non-exclusive filters, so you can select as many of them as you wish.

3 To convert all PostScript files to PDF automatically, select Convert PS to PDF and a job option
from the Distiller Profile menu in the PS->PDF Normalizer pane.

4 Click OK.
For information about Hot Folders, see Utilities.

For more information about Hot Folders Filters, see Graphic Arts Package.

For information about using the Hot Folders application, see Hot Folders Help.
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